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Release Notes for Reporter 3.6

What's New in this Version
New Features
e Enhanced report generation for Group and System reports. Repcrys can now generate Group and System reports automatically, if you have a
ALL template. For more details, refer to 'Concepts Guide, Chapter-4 -Generated and Custom Report.
e Crystal Reports 10 support. You can now generate reports designed in Crystal 8.5, 9.0 and 10.0. Refer to Crystal 10 limitations and known
problems.
e Reporter can now connect to remote HP OpenView Operations for Windows (OVOW) system to get managed node information. Refer to ‘How
to configure Reporter to Remote OVOW server ' section in Installation and Configuration guide.
For huge reports, you can set PAGE_BREAK option in Reporter GUI.
Reporter can be installed on Microsoft Cluster Environment. Refer to the Installation and Special Configuration guide for more information.
Support for IS 6.0.
Support for long host names. System names can be more than 200 characters (up to 1024 characters) but this is not supported on MS Access.

Changes to Installation and New Requirements

e Reporter now requires installation on a system with an 1IS 5.0 (or later) Web server. If you access the main Web page through the Web server,
the link will be usable from other systems. Start a Web browser and access the following URL:
http://<myserver.domain>/HPOV_Reports/reports.htm

e The default repository for Reporter has changed from Microsoft SQL Server 2000 Desktop Engine (MSDE) to Microsoft SQL Server 2000
Desktop Engine (MSDE) SP3a.

e A new installation of Reporter will install the MSDE SP3a database unless it detects a ‘Reporter?ODBC DSN (Data Source Name) on the
Reporter system.

e The installation now installs MDAC 2.7 Service Pack 1a. MDAC 2.7 SP1a has no feature changes from the version of MDAC installed by SQL
Server 2000 (MDAC 2.6), but it does include fixes and security enhancements components. For more details, refer to the installing, upgrading,
and uninstalling section.

Changes to Database Support
e The default repository for Reporter is now Microsoft Database Engine (MSDE) SP3a. This is a component of the SQL Server 2000 database.
e Microsoft Access continues to be a supported database for this release (Long hostnames are not supported).
e Reporter also gathers data from OV Operations 6 and 7 and 8(OVO UNIX) using an Oracle 8.1.7 or 9.2.0 database

Report Definition Package Changes

e OV Operations for UNIX 8 is newly added.
e Report package IT/Operations 5.3 is obsolete now.

Summary of Changes
New Report

Package Description Replace Package
OV Operations for fInstall the OVO/UNIX 8 package to get  |[None
UNIX 8 the new EVENT and SERVICE reports for|

systems managed by OVO/UNIX 8. This
package does not contain the additional
Service State History Reports.

Changes to Reporting
Reporter generates GUIDs for systems with host names longer than 200 characters. Hence, there is a report (a_ovounix_systems_8.rpt and
g_ovounix_systems_8.rpt) that lists the mapping between GUIDs and the host names.

Miscellaneous Changes
New report templates are added for OVO for UNIX.

Fixes in this Release

To print the fixes, first expand those items by clicking Show all. To return to the streamlined view where you click items only as you need them, click Hide all.

| Showall || Hideall |

QXCR1000027171: GatherCODA does not collect data for last 'x' days when 'Retain Days' is not a multiple of seven.
FIX: Gathercoda now collects data even if the total retained number of days is not a multiple of seven.
QXCR1000027180 : Reporter - changing the Database field in the GUI doesn't refresh.
FIX: The Reporter GUI is modified to fix this problem.
QXCR1000026837 : OVR does not differentiate between OVR and OVIS customers.

FIX: In this version, the repcrys module does not schedule performance reports to the OVIS customer.
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QXCR1000027356 : Reporter 3.5. Running RepCrys changes the WebServerPort value.

FIX: In this version, the repcrys module does not change the registry key set for Web server port by other OV products.
QXCR1000048890 : SECURITY: Cannot modify default passwords for ReporterLite db logins.

FIX: The ovrpwdencrypt.exe utility provided in this release can be used to change database logins.
QXCR1000026646 : Table Name is truncated to 26 characters for new 'Metric List'.

FIX: The Reporter GUI is now modified to validate the length of the metric list.
QXCR1000047735 : Trace information about oracle version is wrong.

FIX: The Reporter trace now shows the correct oracle major version.
QXCR1000027095 : Documentation inadequate about which reports can be assigned to customer.

FIX: The Concepts Guide is updated to provide this information.
QXCR1000027318 : OVR3.5 screen date range is blank after date is set and screen refreshed.

FIX: The Reporter GUI is now modified to solve this problem.
QXCR1000026997 : MSCS Support for Reporter 3.6.

FIX: Reporter 3.6 can now can be installed on Microsoft Clustered Server (MSCS) on Windows 2003.
QXCR1000026442 : ER: Reporter - would like customer name to allow 50 characters.

FIX: Support for adding customer names which include up to 50 characters is provided in this release.
QXCR1000027346 : Reporter does not collect Avail Memory and Avail Swap for OVPA/Linux.

FIX: The Discovery module is now modified to collect Avail Memory and Avail Swap metrics from OVPA/Linux systems.
QXCR1000027523 : Duplicate entries for the same system in the OVO/UNIX Group.

FIX: The Discover_I1TO and Reporter GUI modules are modified to fix this problem.
QXCR1000027061 : OVIS- repmaint accesses wrong tables if customized shifts are used.

FIX: In this release, the OVIS tables which do not use shift columns are not modified by the repmaint module.
QXCR1000044632 : Data Collections need indexes on DATET IME & SYSTEMNAME.

FIX: The gather and gathercoda modules now create a composite index for system name and Datetime. This speeds up
database operation.

QXCR1000205159 : Reporter service startup fails when data base password ends in "p".

FIX: The Reporter database password encryption and decryption logic have been modified to solve this problem.
QXCR1000086953 : Collection tables shows wrong GMT time.

FIX: The Gather and Gathercoda modules are modified to update the GMT value properly.
QXCR1000029046 : "Use datasource as Systemname" option does not work for single system.

FIX: The Gather and Gathercoda modules are modified to collect the metrics with the Use datasource as Systemname
option.

QXCR1000027108 : A function to rename the customer.
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FIX: In this release, you can rename an existing customer.
QXCR1000028223 : Changing the Shift in the GUI does not refresh for next report template.

FIX: The Reporter GUI is now modified to solve this problem.
QXCR1000028438 : ER: should have a "select all" in the config. status window dialog.

FIX: In this release, you can access the select and deselect status panes by clicking on the Select All/Clear All toggle button.
QXCR1000028437 : ER: Reporter should provide option to set IDLE TIME OUT/Hang timer value.

FIX: You can now modify the HANG_T IMER value using the GUI.
QXCR1000027560 : If the report description has changed the DB name is affected too.

FIX: The Reporter GUI is modified to solve this problem.
QXCR1000046939 : sapassword visible in install log.

FIX: The installation log files now encrypt the database password.

Announcements

HP OpenView Reporter is copyrighted and licensed by Hewlett-Packard Development Company. Please refer to the licensing agreements on the installation media.
Reporter's primary function is to generate reports as Web pages from data gathered from the OpenView Performance Agent for UNIX or Windows, (formerly known a
MeasureWare Agent) OpenView Operations Agent, version 7 and 8 (performance subcomponent called Coda) or OpenView Operations for UNIX databases (event
and service data). Reporter includes a high degree of automation and flexibility due to its many features, including:

e Immediate, automatic results upon installation.Routine, automatic update of data from OpenView Performance Agents and OpenView Operations Agents,
version 7 and 8, manual configuration of new sources is not required. Application reporting offered by Smart Plug-Ins (SPIs) for Oracle, Informix, Sybase, SAF
R/3, Microsoft Exchange, and others. Wide variety of reports to help you understand and manage your computing resources. Reports are generated as Web
pages, so that staff members throughout your organization can easily access them using a variety of Web browsers.Easy operation: Reporter runs as a
background service, automatically gathering and updating data, which it uses to refresh the Web reports each night.Easily customizable: Although Reporter
runs out-of-the-box, you control Reporter operations through simple drag-and-drop actions in the main window. You can modify the reports or create your own
by purchasing the inexpensive report-formatting application Crystal Reports 10.0 Professional(TM) from Business Objects. Heterogeneous: Reporter runs on ¢
Windows 2000 , Windows 2003 or Windows XP operating system and can gather data from OpenView Performance Agents and OpenView Operations
Agents, version 7 and 8. It can also gather event and service data from an OpenView Operations for Unix management server database, which stores data
gathered from a wide variety of systems.

e Service levels for Reporter transactions available: Application Response Measurement (ARM) instrumentation is included in the Reporter software. If OV

Performance Agent is running on the Reporter system, you can produce reports that show response times and other key transaction metrics for primary
Reporter functions (Discover, Gather, Report Engine, and others).

Software Requirements

e Windows 2000 Professional with Service Pack 4 or Windows 2000 Server/Advanced Server Service Pack 2 or Window XP Service Pack 1 or Windows 2003
Enterprise/Data center Editions. IS 5.0 or later Web server A Web browser for viewing the HTML reports or for using On Demand Reports; IE 5.0 or later, or
Netscape 6.1, 6.2 or 7.2 (Netscape 6.0 is NOT supported). (Optional) Java 2 Runtime, Plug-in 1.3 for using the Java graphs feature in On Demand Reports.
The end-user may be prompted to download this plug-in the first time their browser invokes the Java feature. The plug-in may be pre-installed on the user
system. Virtual memory should be set to an initial size of 200MB or larger on the system running Reporter. Systems running other applications may require
larger virtual memory settings to accommodate Reporter in addition to the other applications. (Optional) OpenView Performance Agent for Windows or UNIX
(MeasureWare Agent) versions. (Optional) OpenView Operations for Windows version 7.5 or OpenView Operations Agent, version 7 and later.

e (Optional) OpenView Operations for UNIX version 6 ,7 or 8 on a HP-UX or Sun Solaris management system.

At this release, OV Operations management server is supported using HP-UX or Sun Oracle 8.1.7 or 9.2.0. You must have access to the Oracle Client
Software - Version 8.1.7 or 9.2.0. The client software is available from the Oracle software supplier or Web site at:
http://otn.oracle.com/software/products/oracle8i/software_index.htmSelect Oracle8i Enterprise Edition Release 3 (8.1.7) for Windows 2000/XP, and fill
out the qualification form. The frame will update. Now look for the client.

We recommend using the same version, or a newer version, of "Oracle Client Software" to connect to the Oracle databases. If you are using the Oracle
8.1.7 client software, please use the 8.1.7.2 patch as this fixes an Oracle memory leak problem.

e (Optional) Reporter database supported with this release are Oracle 8.1.7 or 9.2.0 on HP-UX or Sun Solaris. You need to have the CD set for Oracle.
Specifically, during installation, you use the two CDs entitled "Oracle Client Software - for Windows " and either "Oracle Server for HP-UX 10.20 or 11.0" or
"Oracle Server for Sun SPARC Solaris."

We recommend using the same version, or a newer version, of "Oracle Client Software" to connect to the Oracle databases. If you are using the Oracle
8.1.7 client software, use the 8.1.7.2 patch because it fixes an Oracle memory leak problem.

Hardware Requirements
e Intel Pentium, 500MHz or faster processor with 256 MB of memory or more are recommended. Installing on a slower system or one with less memory may
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prove unacceptably slow for most users.
o For up to 1000 agents, excellent performance is achieved with 500MHz processors with 256-512MB of memory.

O For larger installations consult the information on scalability in the "Scalability" chapter of the Reporter Concepts Guide.
210 MB of disk space for product, data, and system files.

o Slightly more space may be required during product installation, depending on the installation method. 1 GB is recommended as a starting point for the
Reporter database. Initial estimates indicate that the database can hold data from 100 systems (7 days total) in less than 6MB of disk space, but this
number can vary.

o For in-depth information on scalability and disk space requirements, see the chapter "Scalability" in the Reporter Concepts Guide.
e Temporary disk space during report generation may range from 50-800MB, depending on the number of systems in your Reporter database.

Supported Platforms and Databases
Supported Platforms

e Windows 2000 Professional - SP4 Windows 2000 Server - SP4 Windows 2000 Advanced Server - SP4 Windows XP - SP1
e Windows 2003 -Enterprise/Data center Editions.
Supported Databases
Reporter Database Operating System
IAccess 2000 (No long host \Windows 2000 Pro/Svr/Adv -- SP4
name support)
SQL Server 2000 e Windows 2000 Pro/Svr/Adv -- SP4Windows XP
Professional -- SP1
e \Windows 2003 -Enterprise/Data center Edition
MSDE SP 3a e Windows 2000 Pro/Svr/Adv --SP4Windows 2003 -
Enterprise/Data center Edition
e Windows XP Professional -- SP1
Oracle 8.1.7 e HP-UX 11.0 (32 bit)HP-UX 11.0 (64 bit)Solaris 2.7, 8 (32
bit)
e Solaris 2.7, 8 (64 bit)
Oracle 9.2.0 e HP-UX 11.0 (32 bit)HP-UX 11.0 (64 bit) Solaris 2.7, 8 (32
bit)Solaris 2.7, 8 (64 bit)
e Solaris 9

Supported/Unsupported Platforms and Databases in Cluster

Windows Operating Systems EinI{ioS:rver 2000 Enterprise Oracle(All Versions) MSDE (All Versions) I/-\ccess (All Versions)

Windows Server 2003,

Enterprise EditionYN N

N
Windows Server 2003,
Datacenter EditionYN N
N

Platforms and Databases Not Supported
Platform not supported

e Windows NT Server

e Windows NT Workstation
Databases not supported
Reporter Database Operating System
IAccess 97 All platforms
IAccess 2000 NT Workstation/Server -- SP 6A XP Professional -- SP1
SQL Server 7 All platforms
SQL Server 2000 NT Workstation/Server -- SP 6A
MSDE NT Workstation/Server -- SP 6A
Oracle 8.0.6 All platforms
Oracle 8.1.6 All platforms
Oracle 8.1.7 HP-UX 10.20

Handling Services During Installation
This section explains how the Reporter installation handles various services while it is installing.

e The Reporter installation will stop the Reporter Service, World Wide Web Service, 1IS Admin service, and any other service that are dependencies of these
services. These services will not be available for the duration of the installation. These services must be stopped to perform updates for files that these
services may have locked. Special care should be taken for services that are dependant on these services that the installer may be unaware of. These
dependent services will remain stopped until they are either restarted manually or by a system restart. If the installer is unable to stop or start any of these
services, then the installation will create an error dialog that will prompt for a retry. If these services are not stopped or started, the retry continues to fail and
the user chooses to cancel the installation, then all products installed will be rolled back in an abort state of the installation. On occasion the World Wide Web
service may be stuck due to an in-process failure of the inetinfo.exe process. In some cases, sending a kill signal to the inetinfo.exe process can stop this
service. (See Known Problem QXCR1000043281).

e All of these services must not be set to "disabled" for the installation to continue. If the services for IS are disabled, the installer will perform an error check an
warn the end-user.

Installing, Upgrading and Uninstalling
Please refer to Section 1 of the Reporter Installation and Special Configurations Guide for instructions. This section of the Release Notes explains changes specific tc
this version and things you should know before upgrading. Please also read about how the installer handles services during installation. Contents of this section:

e New Installation Upgrading Reporter 3.1 to Reporter 3.6 Upgrading Reporter 3.5 to Reporter 3.6
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e Install and Uninstall with integrated products

New Installation
e If you are installing Reporter for the first time, the default installation directory is C:\Program Files\HP OpenView. All of the products that are installed later
(OVPA, OVIS, OVOW, etc.) will be installed in the same directory.
e Incompatibilities with SQL Server 2000:
O MSDE and SQL Server 2000 are incompatible and cannot both run on the same system. This is due to dependencies on different versions of
Microsoft's MDAC libraries. A new installation of Reporter will install the MSDE database unless it detects a SQL Server 2000 (client or server) on the
Reporter system. If it does not find a configured Reporter ODBC Data Source Name (DSN), it will install a Microsoft SQL Server 2000 Desktop Edition
SP3a database.
o If you wish to use a SQL Server 2000 version for your database, follow the instructions in the Installation and Special Configurations Guide, SQL
Server database setup. You must install SQL Server 2000 and configure the Reporter ODBC Data Source Name (DSN) BEFORE you begin the
Reporter installation.

e Crystal 10.0 runtime DLLs are installed.
e Installation on OpenView Operations for Windows 7.5 management server or managed node is supported.

Upgrading Reporter 3.1 to Reporter 3.6

You can upgrade Reporter 3.6 over an existing Reporter 3.1 installation. The installer will check for an existing Reporter DSN (ODBC Data Source Name) or Reportei
data repository of any database type. If it finds one, it will upgrade the Reporter product files and will update your existing database to upgrade tables and fields
necessary for 3.6. It will not install MSDE.

Note:If MSDE SP3 was used as Reporter 3.1 database during upgradation to Reporter 3.6, MSDE will be upgraded to MSDE SP3a. MSSQL$OVOPS must not be
stopped before the upgrade.

Changes to the installer during an upgrade from Reporter 3.1 to 3.6
Installer prompts user to enter SA password, if Reporter DSN is configured with MSDE instance.

Upgrading Reporter 3.5 to Reporter 3.6

You can upgrade Reporter 3.6 over an existing Reporter 3.5 installation. The installer will check for an existing Reporter DSN (ODBC Data Source Name) or Reporte!
data repository of any database type. If it finds one, it will upgrade the Reporter product files and will update your existing database to upgrade tables and fields
necessary for 3.6. It will not install MSDE.

Note:If MSDE SP3 was used as Reporter 3.5 database during upgradation to Reporter 3.6, MSDE will be upgraded to MSDE SP3a. MSSQL$OVOPS must not be
stopped before the upgrade.

Installing with OV Operations for Windows 7.5

e With a new installation of Reporter and OVO/Windows 7.5 on the management server, you may install in any order.

e When installed and running with OVO/Windows 7.5, you will see some new system groups with very long names in the Reporter User Interface under
Discovered Systems. These are groups obtained from OVO/Windows 7.5.

Install and Uninstall with Integrated Products (OV Operations for Windows 7, OV Internet Services, OVPM) on a system
OVIS 5.2 (or later ) and OVOW 7.2 1 ( or later ) versions can co exist with Reporter 3.6.

Caution: Uninstalling Reporter 3.6 from a system that has OVOW 7.1 or OVIS 5.2 can destabilize report generation.

What to Look for During and After Installation

e Automatic/Manual Service Startup: During the installation of Reporter, you are prompted to select between Automatic and Manual startup of Reporter
Service. In most cases, you should select Automatic. This selection allows Reporter actions to start immediately after your installation is completed and the
system has been rebooted. For more information, see the Concepts Guide.

If you chose manual startup during installation, Reporter service can be manually started using the Start/Stop Reporter Service toolbar button in
Reporter's main window, or alternatively, you can open the Microsoft Windows Control Panel, select Services, and choose Reporter Service. You will
also need to set the service to Automatic startup so it will restart when the system is rebooted.

e Report Package Selections: During a new Reporter installation, report configuration packages (for OV Performance Agent for Windows/UNIX) and OV
Operations Agents, version 7 and later) are automatically installed. To generate additional reports, you can select other Reporter packages (such as OV
Operations for UNIX 6 & 7). For more information, see "Getting Started" in the Reporter Concepts Guide.

Reporter can automatically locate systems running OV Performance Agent for Windows and OpenView Operations Agents, version 7, and produce
your first reports unattended. Reporter must be configured to discover systems running OV Performance Agents and OV Operations 7 Agents on UNIX

systems.

Note: If you do not have any OV Performance Agents or OV Operations Agents, version 7 running in your domain, some of your reports may be blank.

e View what happens after installation: You can view the Reporter activities in the main window status pane. For an overview of Reporter, select Reporter
Help from the Help menu (or click the Reporter Help toolbar button).

By selecting Show Reports, the browser window will display Reporter's cover Web page, which has links to all reports just generated. Each day these
reports are updated with the most recently collected data. There is also a link to the On Demand Reports Web.

e You can learn more about Reporter by doing the following:

O Open Online Help by selecting Reporter Help from the Help menu in the main window. Online Help offers descriptions of Reporter components anc
step-by-step instructions on how to accomplish different tasks. Most step-by-step instructions include a Show Me button, which you can select to view
an animated, narrated demonstration of the task. Open context-sensitive Help by right-clicking any item in the Reporter hierarchy and selecting
Reporter Help from the shortcut menu. For selected dialog boxes Help is available by clicking the Help button.
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O Access the Concepts Guide, the Installation and Special Configurations Guide, and the Release Notes from the Reporter Document Set toolbar
button in the Reporter GUI toolbar or from the Help menu. The Reporter Concepts Guide is an online manual that provides information on how
Reporter works. The Installation and Special Configurations Guide provides information on how you can customize Reporter. To print either guide, lool

for them in Adobe Acrobat format in the Reporter Help directory

How Reporter Starts

After a typical Reporter installation, Reporter starts automatically at system startup. Because Reporter runs as a service, you do not have to be logged on in order for
it to function. If necessary, you can start and stop the Reporter service manually by selecting Reporter Service in the Services Control Panel. At any time you can set

Reporter to automatic startup by changing the Startup Mode to Automatic.

Services
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The HP OpenView Reporter Folder
Note: You can select a different program folder during installation.

Click Start from the Task Bar. Select Programs, HP OpenView, Reporter. You should see the following icons.

@ Opens the Reporter main window.

Reporter

Displays the reports through your Web browser.

Reporter
WebPage

(Reporter User Interface) if the GUI is open.
Status

o Runs the perfstat program, which displays performance programs running. The
E ReportSvc (Reporter Service) program should be running, as should the Reporter

Known Problems, Limitations and Workarounds

The following areas of Reporter are either incomplete or known to not function as expected in this release.

e Migrating from MSDE to Oracle. The current set of instructions for migrating from MS Access to Oracle describes using the Oracle Migration Workbench
(OMWB). The OMWB is designed to handle several different source database formats depending upon the “plug-in". At the time of this release, the plug-in for
SQL Server (MSDE) failed to work correctly. There is a problem with specifying the tablespace that the indexes should be placed in. Oracle is working on this
problem. Therefore, we did not include documentation for using OMWB to transfer from MSDE to Oracle. Please check the Oracle web site for updates to the

Migration Workbench.

e Migrating from MS Access to MSDE. For this type of migration, please refer to www.microsoft.com for the instructions and tools.

e QXCR1000043560: When a product containing an embedded reporting component is uninstalled, and the parent product does not remove this reporting
component, the Reporter ODBC Data Source Name (DSN) and the database with all the configuration information is left on the system. If Reporter is installed
after this, and the user does not first remove the database and DSN, the new install will use the old database. All the configuration information will be retained

and may cause error messages, as the configuration may depend on files that were not reinstalled by the new version of Reporter.

Workaround: Choose one of the following options
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e Remove the database and DSN before installation.
o Remove the report configuration data from the Reporter database using the Reporter GUI.

o QXCR1000043280: MSDE installation fails if SNMP Services are running. Check the MSDE install log file (\data\HPOVInstal\MSDE_Install.log) for the
following error:

Registering performance counters from sglctr.ini PerfmonLoad routine returned error code 6

Workaround: Stop both SNMP Service and SNP TRAP Service, then run the installation again.
e QXCR1000043281: Uninstall cannot stop IISAdmin service, and hangs.

Workaround: Use Windows Task Manager to kill the "inetinfo" process. Keep killing it if it keeps starting up, and do so until the Reporter uninstall is
completed.

e QXCR1000042661: Database Engine.msi internal error 2755 could be encountered during an installation. The reason the installation fails is because the
c:\winnt\installer directory does not have read or write access.

If you manually try to access the directory on the system you will get a permission denied error message. To correct the problem it is necessary to
change permissions on the folder so that Administrators and System have full control and Users have read/execute. Further information about this
problem can be found in Microsoft Knowledge base article, Q276198.

e R555008874, ROSmm14340: When migrating the Reporter MS Access database to SQL Server 7 or 2000, nonstandard Reporter tables are created without ¢
primary key. SQL Server's migration tool does not move indexes. You need to run "NewDB -empty" so that the tables and indexes will be built before the data

is loaded.
Workaround: There are two options to fix tables built by a Smart Plug-In (SPI), DSI feed, or other process:

1. From the SQL Server's enterprise manager, make the ID column a primary key and give it the identity property. Display the tables, right-click on
the table you need to fix, and choose"Design Table."

2. Click on ID's Identity box, right-click on ID, and select Set Primary Key.

e QXCR1000043489: During the report generation phase of Reporter, reports for customer created with space in name (FIRST LAST) and underscore in name
(FIRST_LAST) go to same directory. Whichever customer's reports run first will have their reports overwritten with the wrong data. This problem also applies t
group names.

e QXCR1000042378: Reports have too much vertical space under Crystal 8.5/10 & HTML 4.0. Some reports generated under Crystal 8.5/10.0 have gaps
between the sections of the report. No data is lost but nearly a full page of white space may appear in the middle of a report. The blank spaces may

correspond to the area where a page break would have taken place if the report had been printed across multiple pages.

This is an issue with Crystal Reports exporting to HTML 4.0 that we cannot resolve. The Reporter 3.6 version of the RepCrys utility exports only HTML
4.0. These long blank spaces do not show up if the report has been exported under HTML 3.2. Users who develop custom reports under Crystal
Reports 10.0 Professional should design their reports with HTML 4.0 in mind.

e MSDE memory limitation: You may encounter a situation where the embedded Reporter MSDE database is using too much memory on your system. If you
do not have enough memory to start programs or programs are being ended because of memory shortages MSDE may be using too much of your system's
memory.

Workaround: You should first use the Windows Task Manager to check the amount of memory being used by MSDE. If MSDE appears to be taking
too much memory you may limit the amount of memory it consumes by using the osql utility. The limitation that you use is dependent on your system's
configuration. The example below may be used to change the maximum allowed memory of the MSDE server from infinite to 100 MB. At a Command
Prompt enter: osql -U sa -P """ -S _\OVOPS At the osqgl prompt given, execute this sequence of commands. Hit the carriage return key after
each command.

use master

go

RECONFIGURE WITH OVERRIDE

go

sp_configure "show advanced options®, 1
go

RECONFIGURE

go

sp_configure "max server memory®", 100
go

RECONFIGURE

go

exit

Your system will need to be re-booted for these changes to take effect.

e QXCR1000041842: Message in status.Reporter file: "ERROR: System Data Source "Reporter" Not found in ODBC or could not be created". The Reporter MS
Access database (rpmtools\data\datafiles\Reporter.mdb) might or might not be created with the installation. The root problem is that the system account does

not have permission to access the database.

Workaround: Correct the permissions to the database directly. Make sure that the permissions include full control (the failure is when trying to set
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an attribute) for both the login user (so reporter.exe works) and the system account (so the NT Service reportsvc.exe and spawned programs work). If
you cannot perform these steps, then continue on to the following.

Perform the following steps to reconnect a MS Access database for Reporter.

1. Stop the Reporter Service (Control Panel -->Services -->Reporter Service) Open Control Panel > ODBC Data Sources. Choose the
System DSN tab and remove the Reporter entry. Select Add, Microsoft Drivers (*.MDB) and click finish. At the Data Source Name, type in Reporter. You will
have several different options, one is to Select the Database. Choose this option. WARNING!! Do not create a new Reporter.MDB. If the default Reporter.MD}
that was installed during the installation process is still under the directory \DATA\DATAFILES\REPORTER.MDB. Leave all other settings at the default level.

Close the ODBC Admin Tools and Restart the Reporter Service.
2. You should see Reporter establishing a connection with the Reporter.Mdb and Logging in. Everything should start as normal.

e QXCR1000041639: In some cases, Gather.exe cannot reconnect to a OV Performance Agent for UNIX system (MeasureWare Agent) during subsequent
scheduled Reporter runs. Reporter's Data Gathering by System report displays the "status" column as "Time Out."

Workaround: Log on to the OV Performance Agent for UNIX system (MeasureWare Agent) and run the command: mwa restart server. Run the
Reporter Gather.exe program again. If the Reporter database has been purged or moved, you will get the following error in the Reporter GUI:Could not
open Reporter Database Could not find file "(unknown)". Driver's SQLSetConnectAttr failed

Workaround: Recreate the Reporter database of your choice. Follow the instructions in the Reporter Concepts Guide, Advanced Topics,
Recovering a Corrupted Database.

e ARM DLL deletions: Aborted installations or uninstalls of OV Performance Agent on the Reporter system may leave an incomplete version of the Application
Response Measurement library. Symptoms that point to such a situation in Reporter would include failure of discovery, gather, and reporting programs
(immediate termination, error code 128 in the status file). You can verify this problem by running these programs manually from the MS-DOS prompt. If you ge

a message indicating errors in finding the library "libarm32.dII" or "libmi.dll," you should perform this workaround:

Workaround: Install the stub (NOP) ARM library from the \rpmtools\newconfig\ directory. This workaround disables the collection of ARM transaction
data on the affected system. Upon successful installation of the OV Performance Agent, a working ARM library automatically replaces the stub library.
Copy the file \rpmtools\newconfig\libarmnop.dll to your \windows\system32\ directory. Delete any file in the \windows\system32\ directory called
libarm32.dll if present.

Rename libarmnop.dll to libarm32.dll.
e QXCR1000027352:

Summary: TopApplications report for Last7Days only shows 6 days Symptom : "Last7Days" Specifies a range of Date values that includes all dates
from seven days ago to today (including today). Default cycle of Reporter collects data till previous midnight. Due to this reason "TopApplications"
report shows data for 6 days only.

Solution: Use -h option for gather.exe/ gatherCoda.exe to collect the data till last hour.
e QXCR1000157078:

Summary: Unable to read reporter.xml Symptom: Console is unable to display reports tree and "The xml page can not be displayed" is seen in
browser.

Solution: The xml file may contain the "&" sign from the OVOW groupings. Change the groups and remove the "&" sign from the group name.
e On-demand reports on cluster environment are non functional

Summary: On-demand reports on cluster environment are non functional

Symptom: The report page is not displayed in the browser.
e Errorinrunning discover_neutron

Summary: Error message on the discover_neutron status pane.

Symptom: Error message is displayed on the discover_neutron status pane.

Solution: Remove discover_neutron program from scheduler if you are not integrating with remote OVOW management server.

Known Problems, Limitations, and Workarounds for On Demand Reports
e No "trace.Analyzer" file when tracing is enabled

If no "trace.Analyzer" file is generated even when tracing is enabled:
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e Itis possible that the On Demand Report program is not being executed. Execute it manually by executing
<installation_directory>\HPOV_IOPS\cgi-bin\Analyzer.exe.

e If the previous step succeeded, but there still is no trace.Analyzer file, then perhaps the program is not being executed by the Web browser. Try
running a browser and executing the following URL http://<mysystem>/HPOV_IOPS/cgi-bin/Analyzer.exe?-GETNEWFORM: where "mysystem"
is the name of the Reporter server system.

If this fails, the Web server may not be running on that system. Check to see that IIS Web server is running (World Wide Web Publishing Service is
STARTED).

On Microsoft Windows 2000:

1. Start -> Programs -> Admin Tools -> Internet Services Manager Find your server and open it in the tree. Open the Services window Scroll down
and find "IIS Admin Service"
2. Start the service if not running.

e A graph is drawn and the following error message appears: "The metrics in graph were not found on this data source." This indicates that the classe
and metrics do not match those required in the graph definition.

O Check the graph definition and the Reporter data source to make sure they are compatible. Make sure that the date range selected for the graph is for
data for the previous midnight. By default, Reporter does not gather data since midnight. Make sure the Reporter database is present and the ODBC
connection is properly configured. Make sure that Reporter has data in the database. The database must contain a table or view that matches the
"CLASS" specified for this graph. That table or view must contain the referenced metrics.

O Make sure that at least one numeric metric is selected for a line, bar, pie, or area graph.
e The first On Demand Reports Web page returns the following error message: "Database Open error."

If you are using a Microsoft SQL Server database, make sure that the database Security is set for "SQL Server Authentication" rather than "Windows
Authentication." For more information, refer to the instructions in the Installation and Special Configurations Guide.

e The first On Demand Reports Web page returns the following error message: "CGlI Error" or "Incomplete header."

Error messages such as "The page cannot be found" and "CGlI Error The specified CGI application misbehaved by not returning a complete set of
HTTP header" can be caused by the inability to run the Analyzer.exe program.

O Check to see if the file Analyzer.exe is present in the /[HPOV_IOPS/cgi-bin directory. If it is not there, reinstall Reporter
o Determine if the Analyzer.exe program can be run manually. Create a DOS command window (run "cmd"). Change to the directory where the
Analyzer.exe program is installed:
cd Program Files\HP OpenView\HPOV_I10PS\cgi-bin
Ask the Analyzer for its license status:
Analyzer.exe -license

You should get an indication that the product is properly licensed and available for use. Ask the Analyzer for its configuration information:

Analyzer.exe -info
You should get a long list of XML describing the configuration

O If Analyzer.exe can be run manually, try to run it from a Web browser. Run a Web browser. Edit the URL so that it runs Analyzer.exe directly:
http:\localhost\HPOV_IOPS\cgi-bin\Analyzer.exe?-license You should see an error message followed by the license information you saw in step 2.

http:\\localhost\HPOV_I10PS\cgi-bin\Analyzer .exe?-info

If your browser can display XML directly (IE 5.0 or later, Netscape 6.1, etc.) you should see the XML as seen in step 2. On some
browsers, you may have to "view source" to see the actual XML.

e If Analyzer.exe can be run manually, try to run it from a Web browser. Run a Web browser. Edit the URL so that it runs Analyzer.exe directly:
http:\localhost\HPOV_IOPS\cgi-bin\Analyzer.exe?-license You should see an error message followed by the license information you saw in
step 2.

http:\\localhost\HPOV_I10PS\cgi-bin\Analyzer .exe?-info

If your browser can display XML directly (IE 5.0 or later, Netscape 6.1, etc.) you should see the XML as seen in step 2. On some
browsers, you may have to "view source" to see the actual XML.

e Analyzer runs manually, but does NOT run from a Web browser. Check the system PATH variable. Examine your system's environment variables. Look a
the system environment variable PATH. It should contain the OpenView binary directory (by default, this will be C:\Program Files\HP OpenView\ bin).

Whenever the system PATH variable is changed, the system must be rebooted before system services like 1IS can see those changes. If you have not
rebooted since installing Reporter or since changing the PATH variable, you should reboot and retest.

Some installations can have problems when the OpenView binary directory occurs in the PATH variable after another directory containing similar
library names. If you are still having problems, reordering the directory names so that the OpenView binary directory is the first one in the path. Do not
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forget to reboot after changing the path.

e On Demand Reports main Web page access results in browser error "UNRESOLVED HOSTNAME." This means that the fully Qualified Domain Name
(FQDN) is not properly set on the Reporter server.

If you can view the URL in the browser to see what it was unable to find, examine the first part of the URL. It should show a fully qualified version of
your server name (such as myserver.division.company.com). If the URL has only the short version of the server name (myserver or something like
www.myserver.com, you should check your server system network identification information. On Windows 2000, right-click My Computer --
>Properties -->Network Identification -->Properties. Make sure that the server name is correct in the Computer name field (myserver
for example). Click More and make sure that the Primary DNS suffix is filled in properly (division.company.com for example). On Windows XP, select
Start -->Control Panel -->Network.Make sure that the server name is correct in the Computer name field (myserver for example). Select the
Protocols tab. Highlight TCP/IP Protocol and click Properties. Select the DNS tab and make sure that the server name is properly entered into the Host
Name field, and the Domain field contains the rest of the address (division.company.com for example). When you are finished you may have to reboot.
Then reinitialize the On Demand Reports Web page. Create a DOS command window (run "cmd").

Change to the directory where the Analyzer.exe program is installed:
cd Program Files\HP OpenView\HPOV_I0PS\cgi-bin

Analyzer.exe -init

e Java graphs are cut off.

Sometimes, the bottom of the Java graphs may not be displayed. There may also be a wide gray band to the right of the display. This symptom is
caused by improper versions of the Java plug-in being used.

Workaround: Uninstall all versions of the Java Plug-in (use Add/Remove Programs from the Control Panel). Then manually downloaded the Java
plug-in, version 1.3.1_01, from http://java.sun.com/products/plugin.

e QXCR1000043645. When using Netscape from UNIX , and trying to draw Java Graphs, you will get an error if you resize the before the Java applet is done
loading. Wait until the graph has loaded, then resize the window.

e QXCR1000043629: Closing a browser window containing a Java graph may cause Netscape to hang with the 1.3.1_02 Java plugin. Netscape users should
not use the 1.3.1_02 Java plugin -- any previous version of the 1.3.0 or 1.3.1 plugin can be used instead. The problem can also be avoided by moving the

focus out of the applet by clicking on any other window on your desktop and then clicking back in the applet before closing the window.

Workaround: We recommend uninstalling all versions of the Java Plug-in (use Add/Remove Programs from the Control Panel). Then manually
downloaded the Java plug-in, version 1.3.1_01, from http://java.sun.com/products/plugin.

e QXCR1000151680: A Java graph drawn, with multiple systems selected, displays only one of the system names in the graph title. The html graphs display th¢
systems in separate graphs. The Java graphs put all the systems into one graph. The graph template is set up for the behavior of putting systems into

separate graphs, thus displays the system name for each different graph in the title. QXCR1000042889: There is a colored symbol on the right side of the
graph that can be clicked to hide/show a metric. The symbol and the metric should go away when the symbol is clicked, and come back if that spot is clicked
again. Sometimes the symbol becomes visible when it should not.

e QXCR1000043595: If you draw a Java Graph and then change something in the properties (for example, metric color), and then turn Auto Refresh on, the
metric color will go back to its original color when the graph refreshes.

Workaround: Open the graph in the Design tab, make the customizations you want to see and then Save the graph with a new name and redraw it.

e (QXCR1000043644. If you open the Property page on a rotated java graph, the rotation will be lost. Location of graph output files. When On Demand
graphs are generated, the HTML and GIF files are written to a directory based on the parameters used to generate the graph. All files will be located in the
directory, \data\webpages\VPI_AIl_Customers\. You may want to periodically clean out old files from the subdirectories under VPI_AIl_Customers for disk

space management.

e Database open error. Specified driver could not be loaded due to system error 5 (Oracle in OraHome)(err6). This is a problem related to inadequate access
to the Oracle driver. Please change access permissions for the Oracle driver file to include read/execute access for everyone. If this resolves the problem, the
change it and give specific access to only the Anonymous IIS user(and restart IIS afterwards). If not, try changing the access for the Oracle client folder
(ORAHOME).

Known Problems and Workarounds for existing Crystal 8.5 Templates
The templates of Crystal 8.5 (or earlier version), when used with Reporter 3.6, (which uses Crystal 10 binaries) may break the HTML files created by ‘Repcrys’

module. You may have to change the 8.5 templates based on the issues encountered. Please note that all the out-of-the-box Crystal Reports templates that
accompany Reporter 3.6 Full are properly converted and should work fine without any issues.

Note: Crystal 10 has backward compatibility problems with earlier Crystal versions. The modified templates for OVIS, OVOW, and SPI are available at
ftp.hp.com/pub/ovreporter. You can download the readmefirst. txt file to check for updates.

The following changes are applicable for users who wish to use their customized Crystal 8.5 templates with Reporter 3.6.

All the reports can be edited with Crystal Reports 8.5 with the following modifications in order to be able to support Crystal 8.5 and Crystal 10 from the same
templates. If it is required to support text fields longer than 254 characters (or 127 Japanese characters), the reports must be edited using Crystal 10 as there is no
way to do this with Crystal Reports 8.5. But any reports that are edited using Crystal 10 will not work on Reporter 3.5 system.

e Problem: Crystal 10 does not truncate fields based on the field length defined in the report template. So in the exported HTML files, if the data in the databast
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is longer than the field length defined in the report template, the data will overlap with the neighboring field.

Solution: Modify the templates to validate all of the fields to make sure the field defined in the report template is at least the same size as the field in
the Reporter database. It might not be always possible to have the full length of the database fields displayed, as e.g. object or application fields with
254 characters would not leave any further space in the same line to display further information. If possible, the according field should be configured
with the "Can Grow" option, so that the field automatically extends vertically. If this messes up the report design, it is possible to set the "Can Grow"
option with a maximum number of lines =1. In this case, Crystal Reports10 truncates data again, but only for formula fields and with a different
mechanism. So plain database field objects must be placed into a formula and it must be checked if the new truncation mechanism does not truncate

important information.

Sometimes the problem of overlapping can not be solved only using the "Can Grow" option (for example, if there is a field with a big font size, it can
overlap underlying fields despite this option). In this case the problem field can be placed into a separate report section.

e Problem: Exported HTML reports will not have space in the LHS (left hand side).

Solution: Modify templates for LHS space manually by setting the margin for the report. Adding an additional 1/4 inch margin should solve the
problem.

e Problem: The Hyperlink used to display banners is not parsed and hence becomes visible text. The ‘less-than’ and ‘greater-than’ symbols are translated to
character entities, which prevent the text from being recognized as HTML.

Solution: The solution is to use OLE object linking to get some minimal of linking of banners working with Crystal Reports 8.5 and Crystal Reports 10.
Instead of embedding the banner in the report, you have to insert an OLE Link to the banner graphic in the report. This requires to have a fixed location
and size in the banner files and customers can only exchange with banners of an equal size. Also, If customers want to include their own banners in
the reports, they will need to purchase Crystal Reports 10 and modify the reports to include their banners. As they include the banner, they can size the

banner properly inside the report.

e Problem: Boolean or single bit flag fields in the database (such as the SYSTEMS table’s EXCLUDE column) might not migrate correctly to Crystal Reports 1C
The template seems to expect a numeric value in a selection formula that should evaluate to a Boolean.

Solution: Bit flags cannot be used with Crystal Reports10 and Oracle. Oracle knows only the numeric data type and accordingly Crystal Reports10's
data type checking will cause an error if true/false checks are used. Therefore such fields must be implemented as Integer across all databases and

the reports should use "field=0" checking. Using " =0" will work for both Oracle (numeric field) and SQL Server (bit field).
e Problem: Crystal Queries are no longer supported with Crystal Reports10.

Solution: The reports have to be changed to work without queries. If this is not possible (example, if a UNION must be used without any other leading
table) you might be forced to create views in the database to cover this functionality.

e Problem: Every run of Repcys binary creates a set of files with distinct GUIDs as filename and ‘.png’ as extension in the directories that have the generated
HTML files. The user would need only the latest set of ‘.png’ files to view the generated HTML files.

Solution: Schedule ‘Repmaint —clean’ so that the unwanted ‘.png’ files can be removed. It should be scheduled well after RepCyrs has finished
generating reports.

e Problem: When Crystal 8.5 templates are exported (using Reporter 3.6) with 'Page Break' option set, the ‘Navigational' links in them will be broken. This is
because there is a difference in the name of .html files that get generated when exported using Crystal 8.5 and Crystal 10.

Solution: Reporter 3.6 uses Crystal 10 and on exporting with page break, the html files are named as default.html where n=1,2,3..k. [Whereas, the
previous version of Reporter, which uses Crystal 8.5, the generated html files used be named as default.htm and default.htm where n=1,2,3...k] Hence

Crystal Reports 10 designer needs to be used to make the appropriate changes to the links in the report template.
e Problem: Formulas with the global variables and running total fields cannot be used in charts, maps. or cross-tabs.

Solution: In Crystal 10, this is no longer possible. To solve this problem the report needs to be redesigned to work without the use of global variables
in charts.

e Problem: Crystal Reports10 aligns but does not correctly align fields with borders.
Solution: Remove the border from the field formatting and place an empty field with border on top of the value field.

e Problem: Crystal Report 10 cuts the blank spaces or adds empty sections at the bottom of the
report.

Solution: If the last line of the exported report is not completely visible in Internet Explorer, insert a blank text field in the report footer section. Crystal
Reports10 will export the blank section at the end of the report according to the height of the inserted text field.
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Report Report Type (All, Group,
Category Report Package Name Data Sources Single System) Comment
[Top CPU Busy
Performance OVPerformance 01 Systems MeasureWare/Coda A,G
OVPerformance 02 [Top Disk Busy Systems MeasureWare/Coda
OVPerformance 03 To_p F”e System MeasureWare/Coda A, G
Utilizing Systems
OVPerformance 04 Top Network Busy MeasureWare/Coda IA,G
Systems
OVPerformance 05 Top Memory Busy MeasureWare/Coda A, G
Systems
OVPerformance 06 System Resources MeasureWare/Coda S
. . Top Applications by
IApplication OVApplication 07 CPU Used MeasureWare A,G,S
Transactions OVTransaction 10 Most Act!ve MeasureWare A,G,S
Transactions
OVTransaction 11 Systems Perfo_rmmg MeasureWare IA,G
Each Transaction
OVTransaction 12 Transactions by Each MeasureWare A,.G,S
System
IAvailability OVPerformance 20 System Up Time MeasureWare/Coda A,G,S
Inventory OVPerformance 30 Discovered Systems MeasureWare/Coda A,G
OVPerformance 32 Data Classes and MeasureWare/Coda A,.G,S
Dates of Coverage
IAdministration OVAdmin 90 Sch_e_d_uled Reporter Reporter A
Activities
OVPerformance 91 Data Gathering From Reporter A
Systems
OVAdmin 92 Comp!eted Reporter Reporter A
Activities
OVAdmin 93 DLL VerS|0r_1$ and Reporter A
Dependencies

OV/Operations 8.0 for UNIX Event and ServiceReports

Category 4 Report Name g%pg?gg;';iﬁ”‘ Group,
Inventory 31 OVO/Unix 8.0 Systems OV Operations 7 & 8 A,G
OVO/Unix Summary 9200 OVO/Unix 8.0 MessActive OV Operations 7 & 8 A
9201 OVO/Unix 8.0 PeakHours OV Operations 7 & 8 A
9202 OVO/Unix 8.0 WorkUsers OV Operations 7 & 8 A
OVO/Unix Applications 9210 Message Trend by Application OV Operations 7 & 8
9211 Resolution Time by Application OV Operations 7 & 8 A
9212 Top Active Messages by Application|OV Operations 7 & 8 A
OVO/Unix Messages 9220 Active Messages per Severity OV Operations 7 & 8
9221 Message Load per Operator OV Operations 7 & 8 A
9222 Message Trend by Severity OV Operations 7 & 8 A
9223 Unassigned Messages OV Operations 7 & 8 A
9224 Unassigned Messages by Operator |OV Operations 7 & 8 A
9225 Messages with activated TT and ITI JOV Operations 7 & 8 A
9226 JAssigned Messages for Service OV Operations 7 & 8 A
OVO/Unix Message Messagegroup Assignment per )
Groups 9 9230 Operat%rg P ASSIY P OV Operations 7 & 8 A
9231 Message Trend by Messagegroup JOV Operations 7 & 8 A
9232 Resolution Time by Messagegroup OV Operations 7 & 8 A
0233 Top Active Messages by OV Operations 7 & 8 A
Messagegroup
OVO/Unix Nodes 9240 Nodes per Severity OV Operations 7 & 8
9241 Resolution Time by Node OV Operations 7 & 8 A
9242 Top Active Messages by Node OV Operations 7 & 8 A
9243 Assigned Nodes per Node OV Operations 7 & 8 A
Hierarchy
OVO/Unix Node Groups 9250 Message Trend by Nodegroup OV Operations 7 & 8
9251 Node Assignments by Nodegroup OV Operations 7 & 8 A
9252 Nodegroup Assignment per OV Operations 7 & 8 A
Operator
9253 Resolution Time by Nodegroup OV Operations 7 & 8 A
9254 Top Active Messages by Nodegroup|OV Operations 7 & 8 A
OVO/Unix
IAcknowledgments
Message Trend b )
9261 Acknov?”e dgemen¥s OV Operations 7 & 8 A
9262 Message Handling by Operator OV Operations 7 & 8 A
9263 Resolution Time by Severity OV Operations 7 & 8 A
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9264 Resolution Time by Operator OV Operations 7 & 8

9265 Resolution Time Trend

OVO/Unix Configuration  |9270 Inconsistent Server MSI Setting OV Operations 7 & 8 A

9271 Unassigned Nodes OV Operations 7 & 8 A

9272 Unassigned Responsibilities OV Operations 7 & 8 A

9273 Unassigned Templates OV Operations 7 & 8 A

9274 Undistributed Templates OV Operations 7 & 8 A

9275 Ungrouped Templates OV Operations 7 & 8 A

9276 Managed Nodes Control State OV Operations 7 & 8 A

9277 Regrouped Message Groups OV Operations 7 & 8

9278 Distributed Templates OV Operations 7 & 8

9279 Templates and Conditions OV Operations 7 & 8

OVO/Unix Services 9277 [Top Active Messages by Service |OVO 6, OV Navigator A

9278 Message Trend by Service OVO 6, OV Navigator A

9279 Service Status All Data OVO 6, OV Navigator A

0280 ’\S/lervice Severity for the Last Full OVO 6, OV Navigator R

onth

9280 \?\fer\éi;:e Severity for the Last Full OVO 6, OV Navigator R

9280 Service Severity for Yesterday OVO 6, OV Navigator A

9281 Service Status OV Operations 7 & 8 A

9282 Message Trend by Top 10 Services JOV Operations 7 & 8 A

9289 [Top 10 Most "Shaky" Services OV Operations 7 & 8 A

OVO/Unix Summarized  [9500 Messages by System and OV Operations 7 & 8 AG,S
IApplication

0501 Messages by Application and OV Operations 7 & 8 A.G,S

Severity

9502 Operator Acknowledgments OV Operations 7 & 8 A

Pending Messages by Application,
OVO/Unix Pending 9260 font-family: Arial>Message Group. oy operations 7 & 8 A
ode, Node groups, Service and

Severity

Installed Files

Most Reporter files are installed in directories selected during installation. The default directories are c:\Program Files\hp OpenView\bin\ for executables and non-
editable template files, and c:\Program Files\hpOpenView\data for data files and editable templates. The following additional files are installed in the directories
indicated if they are not already present, or if their versions are more recent than the ones present.

In directory <installation directory>\bin\

File Name Binary Version IASCII Version Description
IAVAILMETRICS.DLL 1.3.60.10 1A.3.60.10 Library used by reporter.exe
CFX2032.DLL 3.0.33.0 Chart FX Library, Software FX, Inc.
CODA_ACCESS.DLL 7.50.1.0 A.07.50.01.0 Library to communicate with OV Operations

— lAgent, version 7
DCE.DLL Datacomm library Dascom, Inc.
DISCOVERY.EXE 1.3.60.10 A.3.60.10 Eggrc:trter Discovery engine for OV Performance

Discovery engine for OVO/Windows when
DISCOVER_NEUTRON.EXE 1.3.60.10 1A.3.60.10 Reporter installed on OVO/Win server
DISCOVER ITO.EXE 1.3.60.10 A.3.60.10 Reporter Discovery engine for ITO
DLLVERSIONS.EXE 13.60.10 A.3.60.10 Elsnedss and lists dlls and versions that Reporter
GATHER.EXE 1.3.60.10 1A.3.60.10 OpenView Performance Agent data gatherer
GATHER ITO.EXE 1.3.60.10 1A.3.60.10 ITO (OVO for Unix) data gatherer
GATHERCODA EXE 1.3.60.10 A.3.60.10 gg{r?e:‘;rr Windows 7 performance subagent data
HPMXLICOBJECT.DLL 3.50.20706.2 License Library
HPMXLICOBJECTRES.DLL 3.50.20707.3 License Library
LLBSERVER.EXE 2.5.3.5
NEWDB.EXE 1.3.60.10 A.3.60.10 Reporter database creator
OVBBCBASE.DLL 2.5.3.5 Datacomm library
OVBBCHTTP.DLL 2.5.3.5 Datacomm library
OVBBCIO.DLL 2.5.3.5 Datacomm library
OVBBCNET.DLL 2.5.3.5 Datacomm library
OVBBCSSL.DLL 2.5.3.5 Datacomm library
OVBBCTHREAD.DLL 2.5.3.5 Datacomm library
OVBBCXML.DLL 2.5.3.5 Datacomm library
OVCONSNOTIFY.DLL 1.2.0.0 OV Operations library
PERESTAT EXE 10.0.0.2 S 00.00.02 Shar_ed file that lists performance tools programs,
ersions, status, etc.

PTHREAD.DLL datacomm library ? Dascom, Inc.
REPCRYS.EXE 1.3.60.10 1A.3.60.10 Reporter report generator
REPLOAD.EXE 1.3.60.10 1A.3.60.10 Loads report templates from text file
REPMAINT.EXE 1.3.60.10 1A.3.60.10 Reporter database maintenance
REPORTER.EXE 1.3.60.10 1A.3.60.10 Reporter user interface
REPORTERRESENU.DLL 1.3.60.10 Reporter resource file (English)
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REPORTERRESJPN.DLL 1.3.60.10 Reporter resource file (Japanese)
REPIMPORT.EXE 1.3.60.10

REPORTSVC.EXE 1.3.60.10 A.3.60.10 Reporter service

[TRC.DLL 3.0.3.2 [Tracing library

TRCMSGS.DLL 3.0.3.2 [Tracing library
REPORTSRVCAT.DLL 1.3.60

XERCES-C 2 4 0.DLL 2.4.0.0 Xerces XML parser library

In directory <installation directory>\HPOV_IOPS\cgi-bin

File Name

Binary Version

JASCII Version Description

IAnalyzer.exe

1.4.4.6

JA.04.04.06

Engine for On Demand Reports

In directory C:\Program Files\Microsoft SQL Server\MSSQL$OVOPS\binn

File Name

Binary Version

Description

IADSSECURITY.DLL

1.0.0.1

IADS| SDK Resource Kit library

CMDWRAP.EXE

2000.80.382.0

SQL Login Integration Procedures DLL

COMNEVNT.DLL

2000.80.194.0

(Common Event Model DLL

DBGHELP.DLL

6.0.17.0

\Windows Image Helper

MSDBI.DLL

6.10.8226.0

Microsoft (R) VC Program Database

ODSOLE70.DLL

2000.80.760.0

OleAut driver DLL containing SQL Server sp_OA extended stored
procedures

OPENDSG0.DLL

2000.80.194.0

SQL Open Data Services DLL

SEMMAP.DLL

2000.80.760.0

SEMMAP Resource DLL

SEMNT.DLL

2000.80.760.0

\Window NT Specific DLL for SQL Enterprise Manager

SQLAGENT.DLL

2000.80.760.0

SQL Server Agent event strings DLL

SQLAGENT.EXE

2000.80.760.0

Microsoft SQL Server Agent

SQLATXSS.DLL

2000.80.760.0

SQLServerAgent Active Scripting subsystem DLL

SQLBOOT.DLL

2000.80.194.0

SQLCMDSS.DLL

2000.80.760.0

SQLServerAgent Command Execution subsystem DLL

SQLCTR80.DLL

2000.80.534.0

ISQL Server Performance Acquisition DLL

SQLIMAGE.DLL

5.0.2031.1

\Windows NT Image Helper

SQLMAINT.EXE

2000.80.760.0

SQL Server Database Maintenance Plan Wizard Executor

SQLREPSS.DLL

2000.80.760.0

SQLServer Agent Replication Subsystem Library

SQLRESLD.DLL

2000.80.382.0

SQL Enterprise Manager Reesource DLL Loader

SQLSERVR.EXE

2000.80.760.0

SQL Server Windows NT

SQLSNMP.DLL

2000.80.194.0

MS SQL SNMP Extension DLL

SQLSVC.DLL

2000.80.760.0

Service Layer DLL for SQL Enterprise Workbench

SSMSAD70.DLL

2000.80.194.0

IADSP Net DLL for SQL Server

SSMSLPCN.DLL

2000.80.760.0

Client-Side Local Inter-Process Communication (LPC) Net Library

SSMSRP70.DLL

2000.80.382.0

ListenOn RPC Net Library

SSMSSH70.DLL

2000.80.194.0

ListenOn RPC Net Library

SSMSVI70.DLL

2000.80.194.0

ListenOn VINES Net Library

SSNETLIB.DLL

2000.80.760.0

\Winsock Oriented Net DLL for SQL Server

SSNMPN70.DLL

2000.80.534.0

Named Pipes Net DLL for SQL Server

UMS.DLL

2000.80.760.0

SQL User Mode Scheduler DLL

XPLOG70.DLL

2000.80.760.0

SQL Login Integration Procedures DLL

XPQUEUE.DLL

2000.80.760.0

SQL Server Replication Extended Procs for Queued Updating
Subscribers

XPREPL.DLL 2000.80.760.0 SQL Server Replication Extended Stored Procedures Library
XPSQLBOT.DLL 2000.80.760.0
XPSTAR.DLL 2000.80.760.0 Extended Stored Procedure DLL for SQL Enterprise Manager

SQLDATA.DLL

2000.80.760.0

SQL Sorting Data DLL

SQLSORT.DLL

2000.80.760.0

SQL Sorting DLL

In directory C:\Program Files\Microsoft SQL Server\80\Tools\binn

File Name Binary Version Description
IAXSCPHST.DLL 2000.80.194.0 JActive Scripting Host for SQL
BCP.EXE 2000.80.382.0 SQL bulk copy tool

CLDTCSTP.EXE

2000.80.194.0

SQL Server DTC setup wrapper

CNFGSVR.EXE

2000.80.760.0

SQL Server Server Configuration

CNVREM.DLL

2000.80.194.0

RPC wrapper DLL for two machine version upgrades

CNVSVC.EXE

2000.80.194.0

RPC Service for two machine version upgrades

CUSTTASK.DLL

2000.80.760.0

DTS Custom Task implementation file

DCOMSCM.EXE

2000.80.194.0

SQL Server DCOM SCM Object

DTCSETUP.EXE

4.71.1015.0

MS DTC stand-alone setup

DTSFFILE.DLL

2000.80.760.0

DTSFlatFile Rowset Provider DLL

DTSPKG.DLL 2000.80.760.0 DTSPackage Service Provider DLL
DTSPUMP.DLL 2000.80.760.0 DTSDataPump Service Provider DLL
DTSRUN.EXE 2000.80.534.0 DTS Package CommandLine Execution
OSQL.EXE 2000.80.760.0 SQL guery tool

PFCLNT80.DLL 2000.80.760.0 SQL Server Profiler DLL

SCM.EXE 2000.80.534.0 SQL Setup SCM
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SQLRESLD.DLL

2000.80.382.0

SQL Enterprise Manager Reesource DLL Loader
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SEMMAP.DLL

2000.80.760.0

SEMMAP Resource DLL

SEMNT.DLL

2000.80.760.0

[Window NT Specific DLL for SQL Enterprise Manager

SQDEDEV.DLL

2000.80.760.0

SQL Setup Enumeration APIs

SQLADHLP.EXE

2000.80.760.0

Microsoft SQL Server Active Directory Helper Service

SQLDMO.DLL

2000.80.760.0

Distributed Management Objects OLE DLL for SQL Enterprise Manager

SQLMANGR.EXE

2000.80.760.0

SQL Server Service Manager

SQLREDIS.EXE

5.0.2919.6304

\Win32 Cabinet Self-Extractor

SQLRESLD.DLL

2000.80.382.0

SQL Enterprise Manager Resource DLL Loader

SQLSVC.DLL

2000.80.760.0

Service Layer DLL for SQL Enterprise Workbench

SQLVDI.DLL

2000.80.760.0

Virtual Device Interface for BACKUP/RESTORE

SVRNETCN.DLL

2000.80.760.0

SQL Server Network Utility DLL

SVRNETCN.EXE

2000.80.760.0

SQL Server Network Utility EXE

W95SCM.DLL

2000.80.760.0

SQL Server Windows 95 Lite SCM

MSGPROX.DLL

2000.80.382.0

SQL Server Proxy Message Datasource Provider

In directory C:\Program Files\Microsoft SQL Server\80\Tools\binn\Resources

File Name Binary Version Description
DISTRIB.EXE 2000.80.194.0 SQL Server Replication Distribution Agent
IMPPROV.DLL 2000.80.382.0 Import OLE DB Provider for SQL Server

MERGETXT.DLL

2000.80.382.0

SQL Server Text Merge Resolver

RDISTCOM.DLL

2000.80.382.0

SQL Server Replication Distribution Library

REPLAGNT.DLL

2000.80.194.0

SQL Server Replication Agent Library

REPLDIST.DLL

2000.80.194.0

SQL Server Replication Distributor Provider

REPLDP.DLL

2000.80.382.0

SQL Server Replication Internal Distributor Provider

REPLDSUI.DLL

2000.80.194.0

SQL Server Directory Service Ul Handler

REPLDTS.DLL

2000.80.194.0

SQL Server Replication OLEDB provider Library

REPLERRX.DLL

2000.80.194.0

Microsoft SQL Replication Errors Control 8.0

REPLMERG.EXE

2000.80.382.0

SQL Server Replication Merge Agent

REPLPROV.DLL

2000.80.382.0

SQL Server Replication Merge Provider

REPLPROX.DLL

2000.80.194.0

SQL Server Proxy Merge Replication Provider

REPLREC.DLL

2000.80.382.0

SQL Server Replication Merge Reconciler

REPLSUB.DLL

2000.80.382.0

SQL Server Replication Subscriber Provider

REPLSYNC.DLL

2000.80.194.0

SQL Server Replication Synchronization Manager Handler

RINITCOM.DLL

2000.80.382.0

SQL Server Replication Snapshot Library

SNAPSHOT.EXE

2000.80.382.0

SQL Server Replication Snapshot Agent

SPRESOLV.DLL

2000.80.382.0

SQL Server Replication Stored Procedure Merge Resolver

SQLDISTX.DLL

2000.80.382.0

Microsoft SQL Distribution Control 8.0

SQLINITX.DLL

2000.80.382.0

Microsoft SQL Snapshot Control 8.0

SQLMERGX.DLL

2000.80.382.0

Microsoft SQL Merge Control 8.0

SQLRESLD.DLL

2000.80.382.0

SQL Enterprise Manager Reesource DLL Loader

SSRADD.DLL 2000.80.382.0 SQL Server Additive Conflict Resolver

SSRAVG.DLL 2000.80.382.0 SQL Server Averaging Conflict Resolver
SSRDOWN.DLL 2000.80.382.0 SQL Server Download Only Resolver

SSRMAX.DLL 2000.80.382.0 SQL Server Maximum/Latest Conflict Resolver
SSRMIN.DLL 2000.80.382.0 SQL Server Minimum Conflict Resolver

SSRPUB.DLL 2000.80.382.0 SQL Server Subscriber Always Wins Conflict Resolver
SSRUP.DLL 2000.80.382.0 SQL Server Upload Only Resolver

In directory <windows>\system32

File Name

Binary Version

Description

ADSSECURITY.DLL

1.0.0.1

IADSI| SDK Resource Kit library

ASYCFILT.DLL 2.40.4275.1 OLE for Windows library
ATL.DLL 3.0.8449.0 IATL Module for Windows (ANSI)
COMCAT.DLL 5.0.2195.1 Microsoft Component Category Manager Library

CTL3D32.DLL

Microsoft 3D Windows Controls

DBMSLPCN.DLL

2000.80.760.0

Client-Side Local Inter-Process Communication (LPC) Net Library

DBMSSHRN.DLL

2000.80.194.0

ConnectTo RPC Net Library

DBNETLIB.DLL

2000.81.9031.0

\Winsock Oriented Net DLL for SQL Clients

DZIP32.DLL 3.0.0.15 Inner Media DynaZIP-32 ZIP
IMPROV.DLL 2000.80.382.0

INETWH32.DLL 1.10.1.1 Blue Sky Software

LIBARM32.DLL 3.00.00.00 IApplication Response Measurement Library (stub)
MFC42.DLL 6.0.8665.0 MFCDLL Shared Library - Retail
MSCPXL32.DLL 3.520.9001.0 Microsoft ODBC Code Page Translator
MSSTKPRP.DLL 6.0.81.69 msprop32.0cx

MSVCIRT.DLL 6.0.8637.0 Microsoft C++ Runtime Library
MSVCP60.DLL 6.0.8972.0 Microsoft C++ Runtime Library
MSVCRT.DLL 6.0.8924.0 Microsoft C Runtime Library
MSVCRT20.DLL 2.10.00.00 Microsoft C Runtime Library
MSVCRT40.DLL 4.20.00.6172 Microsoft C Runtime Library Forwarder

ODBC32.DLL

3.520.9030.00

Microsoft ODBC Driver Manager

ODBC32GT.DLL

3.520.9030.00

Microsoft ODBC Driver Generic Thunk
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ODBCAD32.EXE

3.520.9030.00

Microsoft ODBC Control Panel Startup
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ODBCBCP.DLL

2000.81.9031.14

Microsoft BCP for ODBC

ODBCCP32.CPL

3.520.9030.00

Microsoft ODBC Control Panel Device

ODBCCP32.DLL

3.520.9030.00

Microsoft ODBC Administrator

ODBCCR32.DLL

3.520.9030.00

Microsoft ODBC Cursor Library

ODBCINT.DLL

3.520.7326.00

Microsoft ODBC Localized Resource DLL

ODBCJI32.DLL 4.0.6019.0 Microsoft ODBC Desktop Driver Pack
ODBCJT32.DLL 4.0.6019.0 Microsoft ODBC Desktop Driver 3.5
ODBCTL32.DLL 3.51.1029.00 Microsoft ODBC Helper Function DLL
OLEAUT32.DLL 2.40.4275.1 OLE for Windows library
OLEPRO32.DLL 5.0.4275.1 Microsoft OLE Property Support
PDH.DLL 5.0.2174.1 Performance Data Provider Helper
PSAP|.DLL 5.0.2134.1 Process Status Helper

RACLS.EXE 2.0.31.0

RHMMPLAY.DLL 2.0.0.0 \WinHelp Video Player 32-bit
SKY32V3C.DLL 1.0.0.0 Creative Development Image Library

SQLSRV32.DLL

2000.80.380.0

Microsoft SQL Server ODBC Driver

SQLUNIRL.DLL

2000.80.380.0

String Function .DLL for SQL Enterprise Components

VBAJET32.DLL

isual Basic for Applications Development Environment - Expression
Service Loader

VBAR332.DLL

Visual Basic for Apps Expression Svc

In directory <windows>\system32 (Crystal Reports Version 10.0)

File Name Binary Version Description
CRPE32.DLL 10.0.0.533




